Seismic/Eruption: Downloading…                  Page 1 of 1
[image: image1.jpg]xplorations in
Earth Science




[image: image6.jpg]Ce_ntgal Californ Earthqua‘ g
C 1960 2000, M>3



1.  Downloading and installing…                  Page 1 of 11

	
	1. Downloading and installing the SeisVolE computer program(
[image: image7.png]fg? é‘i’t@&éf’-ﬁ?@g—%

.' “j
See where and whén j'.ﬁey occur
° o 4 % o R





	
	Lawrence W. Braile,   

      Professor    

      Department of Earth and  

      Atmospheric Sciences

       Purdue University

       West Lafayette, Indiana
 Sheryl J. Braile, Teacher

       Happy Hollow School

       West Lafayette, Indiana

  January 14, 2002 




Objective:  This module provides instructions for downloading the SeisVolE (Seismic/Eruption) program from the Internet and installing it on your computer.

Information:  SeisVolE is a Windows program although it can be operated on a Macintosh computer if Windows emulation software (Virtual PC or SoftWindows; see information in the SeisVolE introduction: http://www.eas.purdue.edu/~braile/edumod/svintro/svintro.htm) is installed.  SeisVole requires WIN95 or newer, 16MB memory (32MB or more desirable), and at least 30MB of hard drive space (100MB preferred) available.

Downloading:  To download the SeisVolE software, follow the instructions below.  Some optional suggestions are also included that make the program easier to use and maintain.

1. With your Internet browser, go to Prof. Alan Jones’ web page: http://www.geol.binghamton.edu/faculty/jones and find the link seisvole.exe.  (There is also a readme file that provides some information on SeisVolE but is not necessary to download.)

2. Double click on seisvole.exe (about 9MB, so it will take some time to download if you have a slow connection to the Internet) and choose save program to disk when the dialog box appears.  It is convenient to save the install program, which 

downloads in a self-extracting archive, compressed form, in a TEMP or DOWNLOAD folder so that the program can easily be reinstalled if the version that you are using is inadvertently deleted or corrupted. 

3. When the download is complete, go to the TEMP or DOWNLOAD folder and double-click on the seisvole.exe icon.  Several dialog boxes will appear with information on the directory for download. And requesting user information.  Click next and eventually, finish and the program will decompress and be installed in the folder called SEISVOLE.

To re-install SeisVolE: You can re-install SeisVolE and retain files that you have added (such as topographic data files, earthquake data, and saved and “Make Your Own Map” views.  You may want to re-install to update your version of SeisVolE or to correct SeisVolE standard views that have become corrupted.  To re-install, follow the following procedure:

a. Rename your SEISVOLE folder as SEISVOLEOLD.

b. From your DOWNLOAD or TEMP folder double click on seisvole.exe (or download a new version of seisvole.exe from Alan Jones’ website to your DOWNLOAD or TEMP folder as described in number 1, above) to re-install SeisVolE.  Answer the questions in the dialog boxes that appear.  The new installation will put the new version of SeisVolE and related files in a folder called SEISVOLE (on the C:\ drive).

c. Open the SEISVOLE folder and choose Select All from the Edit menu.  Right click on one of the highlighted files and select Copy.  Then go to your SEISVOLEOLD folder and open it.  Right click on a blank area of the screen within the folder and select Paste.  A dialog box will appear that will ask you if you wish to copy the new files over the old files that have the same name.  Select Yes to All.  This procedure will update or correct the standard files in SeisVolE and also retain your own files within the folder.

d. Delete the SEISVOLE folder (these files are no longer needed because you’ve copied them into the SEISVOLEOLD folder).

e. Rename your SEISVOLEOLD folder as SEISVOLE.

f. You will need to create a new shortcut (see number 4 below) and set the shaded terrain files (for use with the Make Your Own Map option, Teaching Module 11) to use etopo5 and topo30 files as described in Teaching Module 12.

4. Open the SEISVOLE folder and right-click on the seismic.exe icon (a square, blue map); select create shortcut.  The shortcut icon will appear in the SEISVOLE folder.  Select it and drag it to the desktop.  SeisVolE can then be started very quickly by double-clicking on the start-up icon (shortcut) on your desktop.

5. Unless you have very limited hard drive space, it is strongly recommended that you download the etopo5.zip file (place in TEMP or DOWNLOAD folder) from Alan Jones’ web page.  This file is a 5-minute (about 8 km) grid of elevations and bathymetry for the world.  The file allows one to create maps of specific areas in the SeisVolE program with an attractive and useful shaded-relief topography background (the standard views included in the SeisVolE program already include shaded-relief topographic map backgrounds).  To open the compressed (“zipped”) etopo5.zip file, you will need a zip program.  If you do not have a zip program on your computer, you can obtain one for free from www.tucows.com.  An efficient and easy-to-use zip program that can be downloaded from tucows is WinZip 8.1 (search for winzip in tucows and download the most recent version).  To open (decompress) the etopo5.zip file (once you have a zip program installed), double-click on etopo5.zip.  The file Etopo5 will be created.  Make a new folder called TOPO within the SEISVOLE folder and place Etopo5 in the TOPO folder. Example of the shaded-relief topographic background maps that can be created with SeisVolE and the Etopo5 file are shown in Figures 1.1-1.3.

6. To transfer SeisVolE to another computer (without an internet connection) and install it, copy the seisvole.exe install file (the set-up file downloaded from Alan Jones’ web site), the etopo5.zip and topo30.zip compressed (“zipped”) elevation files, and any .hy4 files (such as nmeq.hy4) that you may have used to a zip disk (or CD if you have a CD writer).  Copy the seisvole.exe file into a TEMP folder and install as described above.  Copy the other files into the SEISVOLE folder.  Decompress (unzip) the elevation files.
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Figure 1.1  Seismicity and shaded-relief topography map of the India and Himalayas.
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Figure 1.2  Seismicity and shaded-relief topography map of the southern part of the South American continent and adjacent ocean areas. 
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Figure 1.3  Seismicity and shaded-relief topography map of the central Mediterranean including Italy, Greece and the Alps.

7. If you have at least 100MB of hard drive space, we recommend that you download the topo30.zip files.  Topo30 is a 30 second (about 800 meter) elevation grid for the conterminous United States providing data for shaded-relief topographic maps of significantly higher resolution.  You can download topo30.zip from: http://www.eas.purdue.edu/~braile/files/topo30.zip.  Click on the file topo30.zip  (14.6MB) and download to your TEMP or DOWNLOAD folder.  Then, double click on topo30.zip to decompress (requires a “zip” program; see number 5 above if you do not have a zip program on your computer) the file.  Move the resulting file, topo30, to the TOPO folder within the SEISVOLE folder.  An example of a higher resolution topo30 shaded-relief topography map is shown in Figure 1.4. 

8. Instructions for using the etopo5 and topo30 elevation files to produce shaded-relief topographic map backgrounds in the SeisVolE program (“Make your own map” capability), and examples, are given in Teaching Modules 11 and 12.

9. You are now ready to start the SeisVolE program and begin exploring earthquake activity and volcanic eruptions for any area of the world.  A large number of “standard views” are included with the program so that a beginning user can use the program effectively without additional knowledge of the program’s capabilities and the included earthquake and volcanic eruption data.  However, to take advantage of additional features of the program, and to use the program to explore specific earthquake or volcanic eruption features and plate tectonics, to analyze data, and to conduct independent research projects, you will want to utilize the information contained in the remaining SeisVolE teaching modules.
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Figure 1.4  Seismicity and shaded-relief topography for the eastern Great Basin and Wasatch Front areas including Utah and parts of Nevada, Idaho, Wyoming and Colorado.  The topo30 elevation file was used to create the shaded-relief map.

10.   Additional files (topographic data and specialized earthquake catalogs) that are useful for use with the Seismic/Eruption program are described below and are available for downloading.  Some of the earthquake catalogs contain information on earthquakes of small magnitude, such as magnitudes as small as 2.  These data are very useful for delineating seismicity patterns.  Some of the earthquake catalogs contain historical earthquake information dating back many centuries.  These data are useful for analyzing a more complete earthquake history than is possible from the standard SeisVolE catalog (world.hy4; more information about the SeisVolE earthquake catalogs and the .hy4 format is available in SeisVolE through Help, Contents, Miscellaneous, Auxiliary DOS Programs) that is limited to data from 1960 to the present (with updates from the Internet).  The older data also illustrate the variations in reporting and recording of events due to population effects through time.
Files that are useful for SeisVolE:

1. nmeq.hy4 – 1974-2000 earthquakes for the New Madrid Seismic Zone in the .hy4 format used by SeisVolE.  Download and then place in your SeisVolE folder, then select the earthquake file using Earthquake File under the Earthquakes menu.

2. topo30.zip – 30 second (about 800 m grid) topographic data for the conterminous US for making shaded relief topographic images using SeisVolE.  The file is about 16MB in size and expands to 43MB when uncompressed.  If you don’t have a zip program, you can download WinZip (do a search for “winzip”, select the Windows 95/98 version of WinZip; it has a “5-cow” rating, WinZip 8.1 [“shareware”] is a recent version) from www.tucows.com.  Download topo30.zip, unzip with the WinZip program (after the WinZip program is installed, just double-click on topo30.zip); then place the unzipped topo30 file (named topo30) in the folder called topo within the SeisVolE folder.

3. pnw.hy4 – A SeisVolE (.hy4 format) file containing an earthquake catalog for the Pacific Northwest  (PNW) region of the United States.  The data were obtained from the Earthquake Search tool from the USGS website (earthquake.usgs.gov/; select Latest Worldwide Earthquakes, then Earthquake Search in the NEIC Web Site Contents box).  Additional information about the USGS catalogs can be found at: http://neic.usgs.gov/neis/epic/code_catalog.html.  The pnw.hy4 catalog contains 3636 events of magnitude 2 or greater, from March 1, 1973 to December 31, 2001, within the region defined by latitude 42 – 50 degrees N and 110 – 126 degrees W.   To use, download pnw.hy4 and then place in your SEISVOLE folder.   Then, in SeisVolE (Pacific Northwest view or “make your own map”), select the earthquake file using Earthquake File under the Earthquakes menu.  Reset the dates (Control Menu), the earthquake magnitude cutoff (bottom of screen), and the Magnitude/Depth Scale under the Earthquakes menu.  

4. eus.hy4 – A SeisVolE (.hy4 format) file containing an earthquake catalog for the central and eastern  United States.  The data were obtained from the Earthquake Search tool from the USGS website (earthquake.usgs.gov/; select Latest Worldwide Earthquakes, then Earthquake Search in the NEIC Web Site Contents box).  Additional information about the USGS catalogs can be found at: http://neic.usgs.gov/neis/epic/code_catalog.html.  The eus.hy4 catalog contains 2833 events of magnitude 2 or greater, from December 17, 1752  to December 31, 2001, within the region defined by latitude 23 – 50 degrees N and 65 – 105 degrees W.   The catalog was formed by merging the USGS central and eastern US catalog (for years 1534 – 1986) with the PDE catalog (for years 1987 – 2001).  Due to no or inadequate seismograph coverage until the last few decades, there are relatively few events, especially of small magnitude, in the early part of this catalog.  To use, download eus.hy4 and place in your SEISVOLE folder.   Then, in SeisVolE (United States, New Madrid or Northeastern US views, or “make your own map” for an area of the central or eastern US), select the earthquake file using Earthquake File under the Earthquakes menu.  Reset the dates (Control Menu), the earthquake magnitude cutoff (bottom of screen), and the Magnitude/Depth Scale under the Earthquakes menu.

5. isb.hy4 – A SeisVolE (.hy4 format) file containing an earthquake catalog for the Intermountain Seismic Belt (ISB) of the Rocky Mountains area of the United States.  The data were obtained from the Earthquake Search tool from the USGS website (earthquake.usgs.gov/; select Latest Worldwide Earthquakes, then Earthquake Search in the NEIC Web Site Contents box).  Additional information about the USGS catalogs can be found at: http://neic.usgs.gov/neis/epic/code_catalog.html.  The isb.hy4 catalog contains 10134 events of magnitude 2 or greater, from January 13, 1973 to December 31, 2001, within the region defined by latitude 32 – 50 degrees N and 102 – 117.5 degrees W.   This catalog is useful for making maps (with earthquake data down to magnitude 2) for the states of Idaho, Wyoming, Montana, Utah, Colorado, Arizona, and New Mexico.  To use, download isb.hy4 and place in your SEISVOLE folder.   Then, in SeisVolE (United States view or “make your own map” for an area of the ISB), select the earthquake file using Earthquake File under the Earthquakes menu.  Reset the dates (Control Menu), the earthquake magnitude cutoff (bottom of screen), and the Magnitude/Depth Scale under the Earthquakes menu.

6. sww.hy4 – A SeisVolE (.hy4 format) file containing an earthquake catalog for significant worldwide earthquakes (identified because of magnitude, number of deaths or degree of damage).  Only earthquakes that had magnitude estimates and magnitudes greater than 4 were selected.  Six earthquakes that occurred before the year 0 in the USGS significant worldwide earthquakes catalog were omitted.  The data were obtained from the Earthquake Search tool from the USGS website (earthquake.usgs.gov/; select Latest Worldwide Earthquakes, then Earthquake Search in the NEIC Web Site Contents box).  Additional information about the USGS catalogs can be found at: http://neic.usgs.gov/neis/epic/code_catalog.html.  The sww.hy4 catalog contains 2054 events of magnitude 4 or greater, from the year 10 to 1994.  The distribution of events, for all but the last century or so covered by the catalog, is an indication of population (reporting) and historical record keeping.  To use, download sww.hy4 and place in your SEISVOLE folder.   Then, in SeisVolE (World view; be sure to use the Save As command under the File menu to save the view as a different name such as sww), select the earthquake file using Earthquake File under the Earthquakes menu.  Reset the dates (Control Menu), the earthquake magnitude cutoff (bottom of screen), and the Magnitude/Depth Scale under the Earthquakes menu.  Perform another Save As command (selecting the same name such as sww) after you have made these changes. 

7. sus.hy4 – A SeisVolE (.hy4 format) file containing an earthquake catalog for significant worldwide earthquakes.  Only earthquakes that had magnitude estimates and magnitudes greater than 4 were selected.  The data were obtained from the Earthquake Search tool from the USGS website (earthquake.usgs.gov/; select Latest Worldwide Earthquakes, then Earthquake Search in the NEIC Web Site Contents box).  Additional information about the USGS catalogs can be found at: http://neic.usgs.gov/neis/epic/code_catalog.html.  The sus.hy4 catalog contains 3474 events of magnitude 4 or greater, from the year 1769 to 1989.  To use, download sus.hy4 and place in your SEISVOLE folder.   Then, in SeisVolE (United States view; be sure to use the Save As command under the File menu to save the view as a different name such as sus; or a “make your own map” view), select the earthquake file using Earthquake File under the Earthquakes menu.  Reset the dates (Control Menu), the earthquake magnitude cutoff (bottom of screen), and the Magnitude/Depth Scale under the Earthquakes menu.  Perform another Save As command (selecting the same name such as sus) after you have made these changes.

8. cal.hy4 – A SeisVolE (.hy4 format) file containing the an earthquake catalog for California.  Only earthquakes that had magnitude estimates and magnitudes greater than 2 were selected.  The data were obtained from the Earthquake Search tool from the USGS website (earthquake.usgs.gov/; select Latest Worldwide Earthquakes, then Earthquake Search in the NEIC Web Site Contents box).  Additional information about the USGS catalogs can be found at: http://neic.usgs.gov/neis/epic/code_catalog.html.  The cal.hy4 catalog contains 24,519 events of magnitude 2 or greater, from 1800 to 1994.  This catalog is useful for analyzing a longer history of earthquakes in Califonia than is possible with the standard SeisVolE catalog.  However, because of population trends and the lack of seismograph coverage, data in the early 100 – 150 years of this catalog are not complete and may be less accurate.  To use, download sww.hy4 and place in your SEISVOLE folder.   Then, in SeisVolE (California view; be sure to use the Save As command under the File menu to save the view as a different name such as cal; or a “make your own map” view), select the earthquake file using Earthquake File under the Earthquakes menu.  Reset the dates (Control Menu), the earthquake magnitude cutoff (bottom of screen), and the Magnitude/Depth Scale under the Earthquakes menu.  Perform another Save As command (selecting the same name such as cal) after you have made these changes.

Go to List of SeisVole Teaching Modules (in Introduction to SeisVolE Teaching…; Module 0)
( Copyright 2001.  L. Braile and S. Braile.  Permission granted for reproduction for non-commercial purposes.
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